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About This Guide
This guide provides all the information you need to prepare to earn the 
Apple Certified Certified Pro - Level One status. From this guide you can:

• Learn about Apple Certification

• Find out how to take an exam

• Locate resources to help you prepare for an exam

• Review the range of objectives that the exam may cover

• Get a feel for the type of questions that appear on the exam

Becoming an Apple Certified Pro
The Apple Training and Certification program is designed to keep you at 
the forefront of Apple technology. Certification creates a benchmark to 
demonstrate your proficiency in specific Apple technologies and gives you 
a competitive edge in today’s evolving job market.

Apple offers levels of certification: Apple Certified Associate, Apple 
Certified Pro - Level One, and Apple Certified Pro - Level Two. Certification 
exams do not require class attendance. Students who prefer to learn on 
their own or who already have the necessary skills may take an exam for a 
fee.

Apple Certified Associate status validates basic entry-level skills in a 
specific application. Unlike an Apple Certified Pro exam, you can take 
Associate Level exams online from the comfort of your home or office. 
Apple Certified Associate status is appropriate for students, for someone 
preparing for a first job or for college-level programs, or for someone 
interested in validating entry-level credentials. Currently, Apple Certified 
Associate status is not available for Motion 5.

An Apple Certified Pro is a user who has reached the highest skill level in 
the use and operation of Apple’s pro applications as attested to by Apple. 
Students earn certification by passing the online certification exam 
administered only at Apple Authorized Training Centers (AATCs). Apple 
Certified Pro status is appropriate for industry professionals. 

Apple Certified Pro - Level One attests to basic operational knowledge of 
a specific application. Level One exams are administered at the end of 
specific courses, or you may take the exam at an AATC for a fee. 

Apple Certified Pro - Level Two attests to a deeper understanding of the 
application as well as mastery of advanced features. You can take Level Two 
exams only after earning Level One certification. Currently, Level Two status 
is not available for Motion 5.

Many Apple Certification exams are available in multiple languages. Even 
AATCs that do not offer localized courses can still offer localized exams. For 
details, visit training.apple.com/certification/localized.
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What are the benefits of Apple Certification?
Beside differentiating you as a skilled user of an Apple application, 
becoming an Apple Certified Pro allows you to leverage the power of the 
Apple brand. When you pass a certification exam, you receive an email with 
a PDF copy of your Apple certificate, along with instructions on how to 
order a printed or a printed and framed certificate. The email includes 
LinkedIn, Facebook, and Twitter icons to make it easy for you to share your 
certification news with your networks on these sites.  

You also receive a login for the Apple Certification Records System, where 
you can: 

• Update your profile information and opt in to display your Apple 
Certification(s) on the Apple Certified Professionals Registry

• Review your certification progress

• Download your certification logo(s) to use on business cards, resumes, 
websites, and more

• Provide access to employers to verify your certifications

Exam Details 
“Motion 5” by Mark Spencer prepares you to take the Level One 
certification exam to earn Apple Certified Pro status. 

The Motion 5 Level One exam is a computer-based test offered at AATCs. 
To find the closest AATC, visit training.apple.com/locations. 

Many AATCs schedule certification exam sessions at training.apple.com/
schedule. If you don’t see a session scheduled at your nearest AATC, 
contact the AATC and they may be able to schedule a session. Please note 
that all AATCs offer all Mac OS X and pro apps exams, even if they 
don’t offer the corresponding course.  

The Motion 5 Level One exam details:

• Exam number: 9L0-815

• Number of test questions: approximately 45 technical, five 
demographic (unscored)

• The exam uses a random pool of multiple-choice, fill-in-the-blank, and 
interactive-media questions

• Passing score: 80 percent (scores are not rounded; you must earn a 
score of 80 percent or higher to pass the exam)

• Details on exam scoring are at training.apple.com/certification/faq

• Exam duration: One hour thirty minutes

• Some exams are also available in other languages; for details, visit 
training.apple.com/certification/localized

The exam timer does not start until you view the first technical question. 
You may not access any resources or references during the exam. 
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Recommended Exam Preparation

We recommend the following exam preparation strategies:

• Gain experience with the application.

• Learn from experts: Motion 101: Introduction to Motion 5. 

• Study the Apple Pro Training Series book “Motion 5” by Mark Spencer. 

• Review the optional study materials.

• Review the objectives and sample questions in this guide. 

Gain experience with the application
Nothing can substitute for time spent learning the technology firsthand. 
After you read the book and/or take the class, spend time increasing your 
familiarity with the software on your own to ensure your success on the 
certification exam.

Learn from experts
Apple Authorized Training Centers (AATCs) offer classes where you can 
learn hands on with the technology and benefit from the expertise of 
Apple Certified Trainers and your peers. Visit the Apple Training & 
Certification website to find course offerings at nearby AATCs.

Study the Apple Pro Training Series book
Apple Pro Training Series books are the basis for the related Apple 
Certification exams. The book for this exam is Apple Pro Training Series 
“Motion 5.” You can purchase the book at peachpit.com (click here for a 30 
percent discount code). Creative Edge, an on-demand digital library, offers 
subscription access to the Apple Training and Apple Pro Training Series, as 
well as thousands of other reference videos and books. If you use an iPad, 
an electronic version is available on the iBookstore. Some books are also 
available in other languages. Click here for details. 

Review the optional study materials
The following resources may also help you prepare for your certification 
exam, as well as expand your general knowledge:

• Review the appropriate sections of the Motion User Guide at 
help.apple.com/helplibrary/ or launch the documentation from the 
Help menu in Motion. 

• Many online resources allow students to ask questions and learn tips 
and tricks. To access white papers and discussion forums, and learn 
about the many other online materials, visit www.apple.com/
finalcutpro/resources/ and http://www.apple.com/finalcutpro/motion/
all-features/.

• Designed for iPad and iPhone, the Test Yourself app lets students 
review and assess their knowledge of the material in the Motion 5 
Level One exam. The app will be available in early 2012.

• For information on the Apple Pro Training Program, visit 
training.apple.com/.
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Review the objectives and review questions
Even if you’re self-taught or have taken courses that don’t use the Apple 
Pro Training Series curriculum, you can still prepare for the certification 
exam by making sure that you can complete all the tasks and answer all 
the review questions in the following sections.

The exam objectives describe the knowledge domains assessed by the 
exam. The review questions summarize what you should have learned in 
each chapter. Please note that although this guide divides the objectives 
into lessons or knowledge areas, questions are presented randomly during 
the exam. 

The number of test questions drawn from each knowledge area is 
indicated for each of the following lessons.  

Lesson One Objectives
Upon completion of Lesson One, “Getting Around in Motion” in “Motion 5,” 
you should be able to complete the following tasks. Three items from this 
lesson are included in the pool of Level One exam questions. Questions are 
drawn randomly from the following objectives:

• Navigate the Motion interface 

• Add video to a project

• Make transformations

• Add and modify effects 

• Apply blend modes

• Create and animate text 

• Use Library content 

• Output your project

Lesson One review questions
After completing Lesson One, you should be able to answer the following 
questions. 

1. In the Project Browser, what must you do to create and open 
a new Motion project? 

2. Identify the four main areas that are visible in a new project. 

3. How can you precisely center a clip in the Canvas? 

4. Other than in the Timing pane, in what part of the Motion 
interface can you change the play range or adjust a selected 
layer? 

5. Do you have to stop playback to change the scale of a video 
clip? 

6. How do you change the scale of a layer in the Canvas without 
changing its proportions? 

7. Name the three kinds of effects you can add to a layer. 
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8. How can you change the way the pixels of one layer combine 
with pixels of a layer underneath? 

9. Where is all the content that ships with Motion located? 

10. In what part of the Motion interface can you interactively 
view fonts for a text layer without going to the Inspector? 

11. Which keyboard shortcut opens Player mode? 

12. If you choose Export Movie, can you still render in the 
background as long as you open the Share Monitor? 

Answers

1. Select the Blank category in the sidebar and the Motion 
Project in the project stack, and then click Open. 

2. The Canvas, File Browser, Project pane, and Timing pane 

3. Drag the clip and use the dynamic guides with snapping 
enabled, or click the Import button in the File Browser. 

4. The mini-Timeline 

5. No, you can build an entire Motion project while the project 
is playing, although it’s sometimes easier to accomplish 
certain tasks when the playhead is stopped. 

6. Shift-drag a transform handle. 

7. Filters, masks, and behaviors 

8. Change the blend mode. 

9. The Library 

10. The heads-up display, or HUD 

11. F8

12. No, Export Movie renders in the foreground unless you use 
Send to Compressor.

Keyboard Shortcuts

Command-S Save the project

F1 Open the Properties pane of the Inspector 

F2 Open the Behaviors pane of the Inspector 

F3 Open the Filters pane of the Inspector 

F4 Open the Object pane of the Inspector (context 
sensitive depending on the selected object) 

F5 Open and close the Project pane (which opens 
to its Layers list by default) 

F6 Open and close the Timing pane (which opens 
to its Timeline component by default) 
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F7 Show/hide the HUD 

Option-Z Zoom Canvas to 100 percent

Shift-Z Set the Canvas to Fit in Window zoom mode

Spacebar Turn playback on and off

Command-Z Undo the previous action

Lesson Two Objectives

Upon completion of Lesson Two, “Building a Composite” in “Motion 5,” you 
should be able to complete the following tasks. Five items from this lesson 
are included in the pool of Level One exam questions. Questions are drawn 
randomly from the following objectives:

• Apply blend modes and combine with filters 

• Import layered Photoshop files

• Copy layers and filters

• Work with image sequences

• Perform Timeline edits

• Change preferences

• Make clone layers

• Transform and add masks to groups

Lesson Two review questions
After completing Lesson Two, you should be able to answer the following 
questions. 

1. How can you ensure that transparent areas of your project 
will appear black? 

2. You are using the HUD to change the brightness of a filter, 
but even at the maximum setting, it’s not bright enough. 
Where can you enter a higher value? 

3. Name two blend modes that will generally result in a lighter 
image. 

4. Identify two ways to modify the impact of a blend mode. 

5. When you want to make a copy of a layer or group, what is an 
alternative to duplicating? 

6. Identify the three options for importing a multilayered 
Photoshop file. 

7. A client gives you 50 digital photos to use in a Motion 
project. You put them in a folder on your desktop, but when 
you look in the folder using the File Browser in Motion, all you 
see is a single icon. What’s going on, and what can you do to 
see all the photos? 
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8. Name three types of edits you can perform in Motion. 

Answers

1. Choose Edit > Project Properties and set Background to Solid. 

2. In the Inspector 

3. Add, Lighten, Screen, Color Dodge, or Linear Dodge 

4. Lower the opacity of the layer, duplicate the layer, or add a 
colorize filter. 

5. Use Make Clone Layer, which is similar to duplicating, but 
uses less memory, and the clone layer inherits certain 
properties of the original. 

6. As merged layers, as all layers, or by selecting an individual 
layer 

7. The photos are numbered sequentially and appear by default 
in the File Browser as a collapsed image sequence. Click the 
“Show image sequences as collapsed” button to see the 
individual files. 

8. Composite, overwrite, insert, sequential 

Keyboard shortcuts

Command-1 Reveal the File Browser

Command-2 Reveal the Library

Command-3 Reveal the Inspector

Command-D Duplicate the selected layers(s) or group(s)

Command-J Reveal project properties

Command-Shift-N Create a new Group

Command-, (comma) Open Preferences

Command-[ (left 
bracket)

Send the selected layer back (down)

Command-] (right 
bracket)

Move the selected layer forward (up)

Command-Shift-
[ (left bracket)

Send the selected layer to the back (bottom of 
the group)

Command-Shift-] 
(right bracket)

Bring the selected layer to the front (top of the 
group)

Option-drag Create a copy in the Canvas, Layers list, or 
Timeline

K Clone a group or layer
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Lesson Three Objectives

Upon completion of Lesson Three, “Creating Animation with Behaviors” in 
“Motion 5,” you should be able to complete the following tasks. Five items 
from this lesson are included in the pool of Level One exam questions. 
Questions are drawn randomly from the following objectives:

• Create animation using Basic Motion behaviors 

• Adjust, copy, and trim behaviors

• Use Simulation behaviors

• Apply Parameter behaviors

• Clone animated groups

• Compare animation using behaviors and keyframes

Lesson Three review questions
After completing Lesson Three, you should be able to answer the following 
questions. 

1. Name three of the Basic Motion behaviors.

2. You applied a Motion Path behavior and added control points 
to create a curved path. How can you make the layer turn as 
it moves along the path? 

3. If you copy a behavior from one layer to another, will it always 
match the duration of the target layer?

4. How do you trim the Out point of a behavior to match the 
layer to which it’s applied?

5. What type of behaviors mimic physical phenomena such as 
gravity, inertia, and random movement?

6. You added a Grow/Shrink behavior to a layer and would like 
to adjust it using the onscreen controls. What happens if you 
drag one of the blue edge handles?

7. Why would you change a group from a 2D group to a 3D 
group? 

8. Describe two ways to apply a Parameter behavior.

9. What’s one difference between duplicating a layer and 
cloning a layer? 

Answers

1. Grow/ Shrink, Fade In/Fade Out, Throw, Spin, Motion Path, and 
Snap Alignment to Motion are all Basic Motion behaviors.

2. Add the “Snap Alignment to Motion” behavior from the Basic 
Motion category.

3. No, the copied behavior will match the In point of the target 
layer but its duration won’t change from the original. So, if the 
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target layer is longer or shorter than the source layer, the Out 
point of the behavior must be trimmed to match it. 

4. Select a layer in the Timeline and press Shift-O to move the 
playhead to the layer’s Out point. Then press O to trim the 
Out point of the behavior to the playhead. Or drag the right 
edge of the behavior, holding down the Shift key to snap to 
other layers.

5. Simulation behaviors

6. Dragging an edge handle will scale the layer up or down  
non-proportionally over time.

7. You want to composite the layers in the group based on their 
positions in z-space rather than the stacking order in the 
Layers list. Also, certain behaviors will work in 3D only if the 
group containing them is a 3D group. Finally, the lights do 
not affect 2D groups.

8. Drag a Parameter behavior from the Library to a layer, and 
then select the target parameter in the HUD or Behaviors 
Inspector. Alternatively, first choose the target parameter you 
want to animate  and then in the Inspector, click the 
Animation menu for that parameter and choose Add 
Parameter Behavior.

9. A duplicated layer is independent of the original; a clone will 
change when you change certain aspects of the original—for 
example, changing the animation of the original. 

Keyboard shortcuts

D Cycle HUD forward

Shift-D Cycle HUD backward

Shift-V Turn the full view area on and off

Command-Option-I Set a play range In point

Command-Option-O Set a play range Out point

Command-Arrow Nudge the selected layer in the direction of the 
arrow

Shift-Command-
Arrow Nudge in a larger increment in the direction of 

the arrow

Lesson Four Objectives
Upon completion of Lesson Four, “Animating with Keyframes” in “Motion 5,” 
you should be able to complete the following tasks. Seven items from this 
lesson are included in the pool of Level One exam questions. Questions are 
drawn randomly from the following objectives:

• Record keyframes

• Set keyframes manually
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• Use the Keyframe Editor

• Change keyframe interpolation and adjust keyframe curves

• Add, move, and change the values of keyframes on a curve

• Set keyframes for multiple layers simultaneously 

• Change keyframe timing in the Timeline

• Choose keyframe curves for editing in the Keyframe Editor

Lesson Four review questions
After completing Lesson Four, you should be able to answer the following 
questions. 

1. How does Motion let you know that recording is enabled?

2. Which parameters of a layer or group are keyframed when 
recording is turned on and their values are changed? 

3. How many keyframes do you need to create animation? 

4. The position of a video is keyframed at 1:00 and 5:00, but it 
does not move. Why?

5. How do you open the Keyframe Editor?

6. How do you change the interpolation for a keyframe curve?

7. How can you set the interpolation for a keyframe to 
Logarithmic?

8. You want to set a keyframe at 3:15 for the scale of three layers 
that are each in different groups. How can you set it for all of 
them at once?

9. When you set a keyframe with recording enabled at a frame 
that is not at the beginning of a layer, what does Motion do 
automatically? 

10. When setting keyframes manually, which do you do first—set 
the keyframe or change the value—and why? 

11. What parameters can be keyframed?

Answers

1. The Record button turns red, and all keyframeable value fields 
in the Inspector turn red. 

2. All keyframeable parameters will be keyframed by default if 
you change their values. You can change the recording 
options by double-clicking the Record button and selecting 
the checkbox to record keyframes on animated parameters 
only. 

3. To animate with keyframes, you need to have at least two 
keyframes with different values.

4. Because the keyframes have the same value. 
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5. Choose Window > Keyframe Editor or press Command-8.

6. In the Keyframe Editor, from the Animation pop-up menu, 
choose Interpolation. The submenu includes four 
interpolation options: Constant, Linear, Bezier, and 
Continuous. You can also Control-click a keyframe or a curve 
in the Keyframe Editor.

7. In the Keyframe Editor, you can change the interpolation of 
individual keyframes along a curve by Control-clicking a 
keyframe and choosing an interpolation type. This technique 
provides access to five additional interpolation options: Ease 
In, Ease Out, Ease Both, Exponential, and Logarithmic.

8. Command-click each of the layers to select them. Then click 
the Animation pop-up menu in the Properties Inspector for 
Scale and choose Add Keyframe, or click the keyframe icon.

9. Motion automatically sets a keyframe at the beginning of a 
layer if recording is enabled when you change the value of a 
parameter at any other point in time. 

10. Always set the keyframe first and then change the value 
when setting keyframes manually; otherwise, the value will 
change for the entire duration of the layer, not just at the 
keyframe. 

11. Any parameter of any layer, group, or effect that has an 
Animation pop-up  menu in the Inspector. 

Keyboard shortcuts

A Toggle recording off and on

Control-K Add a keyframe for the last animated property

Command-8 Open the Keyframe Editor

Shift-K Move to the next keyframe 

Option-K Move to the previous keyframe 

Lesson Five Objectives
Upon completion of Lesson Five, “Creating Content with Shapes, 
Generators, and Paint Strokes” in “Motion 5,” you should be able to 
complete the following tasks. Two items from this lesson are included in 
the pool of Level One exam questions. Questions are drawn randomly from 
the following objectives:

• Draw shapes 

• Create and modify gradients 

• Apply generators

• Search the Library

• Mask with images
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• Use Shape behaviors

• Import vector graphics

• Work with paint strokes

Lesson Five review questions
After completing Lesson Five, you should be able to answer the following 
questions. 

1. How many color tags can you add to a shape’s gradient in the 
Inspector?

2. How do you reverse the direction of a gradient?

3. Where do you change the fill for a shape such as a rectangle? 

4. How do you create an image mask? 

5. True or false: A source image for an image mask must contain 
an alpha channel.

6. You’ve added a vector graphic in the Illustrator or PDF format 
but when you resize it, it looks blurry. How can you fix this? 

7. How do you create a generator?

8. If you select a category in the Library and it is empty, what 
might be the first thing to check?

9. How does the Paint Stroke tool differ from the Bezier tool?

10. How can you increase the speed of a Shape behavior? 

11. Describe two ways to apply a shape style preset to a paint 
stroke.

12. What behavior can you use to animate the appearance and/
or disappearance of a paint stroke from the first control point 
to the last? 

Answers

1. There is no limit. 

2. Click the Reverse Tags icon next to the color gradient bar.

3. With the layer selected, press F4 to open the Shape pane of 
the Inspector and choose the appropriate option from the Fill 
Mode pop-up menu.

4. In the Layers list, Control-click the appropriate layer, and 
choose Add Image Mask from the shortcut menu. Drag an 
image into the Mask Source drop well.

5. False. An image mask can use an alpha channel, luminance 
channel or a color channel.

6. Switch to the Media List in the Project pane to select the AI or 
PDF file. Then view the Media pane in the Inspector and 
deselect the Fixed Resolution checkbox.
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7. Press Command-2 to open the Library, and select the 
Generators category. Select a generator, and click Apply.

8. Check to make sure the Search field is empty at the bottom 
of the Library.

9. The Paint Stroke tool is a freehand tool. The Bezier tool lets 
you place each control point as you draw by clicking in the 
Canvas. 

10. You can increase a behavior’s speed by shortening its 
duration in the Timing pane or the mini-Timeline.

11. Choose a shape style from the HUD pop-up menu, or drag it 
from the Shape Style category in the Library onto the paint 
stroke layer.

12. The Write On behavior

Keyboard shortcuts

B Select the Bezier tool/B-Spline tool

C Select the Circle tool

P Select the Paint Stroke tool

R Select the Rectangle tool

Shift-S Select the Select/Transform tool

Esc Exit the Rectangle, Circle, or Line tool

Shift-Home Move the playhead to the play range In point

Shift-End Move the playhead to the play range Out 
point

Command-4 Open the Layers list

Lesson Six Objectives

Upon completion of Lesson Six, “Creating Text Effects” in “Motion 5,” you 
should be able to complete the following tasks. Three items from this 
lesson are included in the pool of Level One exam questions. Questions are 
drawn randomly from the following objectives:

• Create, format, and style text layers 

• Save and apply text style presets 

• Format glyphs 

• Animate text with text behaviors

• Customize the Sequence Text behavior 

• Save text animation favorites 

• Animate Text on a path

• Work with motion blur
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Lesson Six review questions
After completing Lesson Six, you should be able to answer the following 
questions. 

1. Name two of the three panes in the Text tab of the Inspector.

2. How do you display the action-safe and title-safe overlays?

3. When modifying an individual character in a text layer, which 
tool do you use to change its scale, position, and rotation; and 
how do you select that tool? 

4. How do you create a marker?

5. From which two locations can you apply a preset text style? 

6. Which behavior was used to create all the text sequence 
presets in the Library?

7. Which text layer parameters can you animate directly in the 
Canvas using a Sequence Text behavior? 

8. What parameter would you adjust to set the number of 
characters animating at once in a Sequence Text behavior?

9. With the Transform Glyph tool, you can change the offset, 
scale, and rotation of a character directly in the Canvas. Where 
are those parameters located in the Inspector? 

10. After changing the Layout Method to Path, what must you do 
to see the path in the Canvas? 

11. Describe one method for turning on motion blur, and identify 
where you can adjust its settings.

Answers

1. Format, Style, and Layout

2. From the “View and Overlay” pop-up menu at the top right of 
the Canvas, choose Safe Zones, or press the ’ (apostrophe) key.

3. You use the Transform Glyph tool, which you can select from 
the 2D Transform tools in the toolbar (the first of three View 
tools), or by Control-clicking a text layer in the Canvas and 
choosing Transform Glyph. 

4. Select a layer and press M.

5. From the Style Preset pop-up menu in the Style pane of the 
Text Inspector, or from the Text Styles category in the Library

6. The Sequence Text behavior

7. Position, rotation, and scale

8. The Spread parameter

9. In the Format pane of the Text Inspector (as opposed to the 
Properties pane, which contains Position, Scale, and Rotation 
parameters for the entire text layer)
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10. Double-click the text in the Canvas.

11. You can turn on motion blur from the Render Options pop-up 
menu, by choosing View > Render Options > Motion Blur, or 
by pressing Option-M. To change its settings, open the Project 
Properties window by choosing Edit > Project Properties, or 
pressing Command-J, and then select the Render Settings 
pane.

Keyboard shortcuts

T Select the Text tool 

Tab Rotate through each available tool for the 
selected object

Esc (Escape) Exit text-entry mode

Option-M Toggle motion blur off and on

(apostrophe) Toggle safe zones display

Lesson Seven Objectives
Upon completion of Lesson Seven, “Working with Particle Emitters and 
Replicators” in “Motion 5,” you should be able to complete the following 
tasks. Four items from this lesson are included in the pool of Level One 
exam questions. Questions are drawn randomly from the following 
objectives:

• Create and modify a particle emitter 

• Use an image sequence as a cell source 

• Browse, apply, and customize preset emitters and replicators 

• Create and modify a replicator

Lesson Seven review questions
After completing Lesson Seven, you should be able to answer the 
following questions. 

1. Name the two particle system components that appear in the 
Layers tab when you make a particle emitter.

2. You created particles from a leaf graphic you found in the 
Library, and made those particles spin by increasing the Spin 
value in the Emitter pane. But you now want each to spin 
each of them at different rates. Which Emitter pane parameter 
do you adjust to do this?

3. What kind of particle-specific behavior do you use to change 
particles’ sizes during their lifespan and what does it get 
applied to?
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4. Your particles appear at random locations on the screen, but 
you want to change those random locations. Which button 
can you click to create a different random pattern?

5. What is a quick way to introduce variations that give your 
particle system a more natural, organic look?

6. What’s the primary difference between a particle emitter and 
a replicator? 

7. How can you animate a replicator’s elements so that they 
fade onto the screen, one after the other?

8. You want to drag the bounding box to resize a replicator but 
the onscreen controls aren’t appearing. How can you display 
them?

9. Name three shapes that can be chosen from the Shape 
parameter pop-up menu for a particle emitter or a replicator.

10. Can you use a QuickTime movie as the source for a particle 
emitter as well as a replicator source?

Answers

1. The emitter and the cell

2. The Spin Randomness parameter

3. Apply the Scale Over Life behavior to the particles’ cells.

4. The Generate button for the Random Seed parameter

5. Use the randomness parameters that appear in the Cell 
Controls section of the Emitter pane. For example, below Birth 
Rate is Birth Rate Randomness, below Life is Life 
Randomness, and so on.

6. A particle emitter creates a continuous stream of particles 
that are born, stay onscreen for some time, and then die. A 
replicator creates a fixed number of elements in a static 
pattern.

7. Use the Sequence Replicator behavior, add the Opacity 
parameter, set the parameter to 0, and set Sequencing to 
From. 

8. The replicator bounding box is available only when you select 
the Adjust Item tool in the toolbar, or Control-click the 
replicator in the Canvas and choose Replicator from the pop-
up menu.

9. Line, Rectangle, Circle, Burst, Spiral, Wave, Geometry, and 
Image. Particle emitters can also have a Point shape. 

10. Yes, you can use images, image sequences, movies, or many 
of the Motion objects (text, generators, shapes) as sources for 
both emitters and replicators.
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Keyboard shortcuts

E Create a particle emitter

L Create a replicator

Shift-End Move the playhead to the play range Out 
point (Shift-FN-Right Arrow on a laptop)

Shift-Home Move the playhead to the play range In point 
(Shift-FN-Left Arrow on a laptop)

Shift-V Show the full view area

Lesson Eight Objectives
Upon completion of Lesson Eight, “Using Audio” in “Motion 5,” you should 
be able to complete the following tasks. Two items from this lesson are 
included in the pool of Level One exam questions. Questions are drawn 
randomly from the following objectives:

• Work with audio in the Audio List and Audio Timeline

• Automate audio levels using behaviors

• Create and edit markers

• Assemble a project from saved Motion groups

• Edit to the beat of an audio track

• Sync animation to audio with the Audio Parameter behavior

Lesson Eight review questions
After completing Lesson Eight, you should be able to answer the following 
questions. 

1. Can Motion work with 5.1-channel surround sound audio 
files?

2. Name two locations in the Motion interface where you can 
work with audio.

3. In what two ways can you adjust audio with behaviors? 

4. What is the difference between project markers and layer 
markers? 

5. You are adding audio markers on the fly and realize that your 
timing was off. How can you remove all markers to start over?

6. If you can’t remember the keyboard shortcuts to create, edit, 
jump to, and delete markers, what is the menu containing all 
these commands?

7. You enabled audio in the transport controls and now Motion 
is skipping video frames as necessary to sync the audio with 
the video and play in real time. How would you turn off the 
audio to play every frame?
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8. True or false: The Audio parameter behavior lets you animate 
any keyframeable parameter of any group, layer, or effect to 
an audio track’s specific frequency range and volume range.

Answers

1. Yes, but you can only hear all six channels when your 
hardware supports 5.1 surround sound. 

2. The Audio list in the Project pane and the Audio Timeline in 
the Timing pane

3. You can automate the audio level with the Audio Fade In/
Fade Out behavior, and you can automate panning with the 
Audio Auto Pan behavior.

4. Project markers appear over the ruler area of the Timeline, 
whereas layer markers are applied directly to a selected layer, 
group, or effect. 

5. Choose Mark > Markers > Delete All Markers.

6. The Mark menu

7. Disable audio in the transport controls, or choose Motion > 
Preferences. Click the Time pane and in the Playback Control 
section, select Pause Audio Playback.

8. True

Keyboard shortcuts

M or ` (grave) Add a marker

Shift-M Add a project marker

Command-Option-M Edit a marker

Command-6 Reveal the Audio list in the project pane

Command-9 Reveal the Audio Timeline in the Timing pane

Command-Option-Left 
Arrow

Move the playhead to the previous marker

Command-Option-
Right Arrow

Move the playhead to the next marker

Lesson Nine Objectives

Upon completion of Lesson Nine, “Speed Changes and Optical Flow” in 
“Motion 5,” you should be able to complete the following tasks. Two items 
from this lesson are included in the pool of Level One exam questions. 
Questions are drawn randomly from the following objectives:

• Speed up and slow down a video clip 

• Apply optical flow frame blending 

• Use keyframes to create a variable speed ramp 
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• Apply, trim, and combine Retiming behaviors

• Use and modify Time filters

Lesson Nine review questions
After completing Lesson Nine, you should be able to answer the following 
questions. 

1. In which pane and section do you change the speed of a clip? 

2. Name the two kinds of Time Remap speed changes.

3. Identify three of the four frame blending options.

4. You created a slow motion effect using the Optical Flow 
option. How can you determine how large the resulting cache 
file is?

5. Can you continue working on a Motion project while the 
optical flow analysis is performed?

6. Describe four reasons to create a speed effect with a 
Retiming behavior instead of using keyframes. 

7. Which Retiming behavior lets you create a speed ramp effect? 

8. Can you combine Retiming behaviors with keyframes?  

9. Name two of the Time filters.

Answers

1. The Properties Inspector in the Timing pane 

2. Constant Speed and Variable Speed 

3. None, Blending, Motion-Blur Blending, and Optical Flow

4. Choose Motion > Preferences. In the Cache pane, click the 
“Reveal in Finder” button, and then select the cache file to 
view its properties.

5. Yes, it’s a background task. 

6. Behaviors can be added and adjusted quickly; they can create 
effects that would be difficult or time-consuming using 
keyframes; Retiming behaviors only change the parts of a clip 
where they are applied; you can change the locations and 
durations of Retiming behaviors right in the mini-Timeline.

7. The Set Speed behavior

8. Yes, if you apply a keyframe curve to a Retiming behavior, 
both keyframes and behaviors manipulate the clip’s playback 
speed.

9. Echo, Scrub, Strobe, Trails, Wide Time 
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Lesson Ten Objectives

Upon completion of Lesson Ten, “Keying and Compositing” in “Motion 5,” 
you should be able to complete the following tasks. Two items from this 
lesson are included in the pool of Level One exam questions. Questions are 
drawn randomly from the following objectives:

• Stabilize a shot

• Match move one shot to another

• Use the Keyer to remove a green screen 

• Create and animate a B-Spline mask

• Match foreground and background color

• Add and customize a particle effect

Lesson Ten review questions
After completing Lesson Ten, you should be able to answer the following 
questions. 

1. You want to create a hole in a layer to reveal the layers 
underneath. You add a mask with the B-Spline tool, but 
instead of creating a hole in the layer, it restricts the layer’s 
visibility to the area inside the circle. How can you make it do 
the opposite?

2. What types of camera movements can you stabilize using the 
Stabilize behavior?

3. When using the Match Move behavior to track the position of 
one layer to another, do you apply the behavior to the layer 
that will inherit the new movement or to the layer that has 
the movement you want?

4. How can you create a sharp corner in a B-Spline mask? 

5. If the shades of the green or blue screen are not totally 
removed when you first apply the Keyer filter, how can you 
add additional shades? 

6. You are looking at a keyed shot and the foreground subject 
has some areas of green fringe around it. Which parameter of 
the Keyer filter do you adjust? 

7. You’ve perfected the matte on your subject, but a white ring 
appears around the foreground subjects. Describe one of two 
approaches to remove the white ring.

8. In what two areas can you find the Light Wrap parameters, 
and when would you adjust them in each location? 

9. How can you check the actual RGB values of an area in your 
clip? 

10. What does the Strength slider do in the Keyer filter?
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Answers

1. In the HUD or the Mask pane of the Inspector, choose 
Subtract from the Mask Blend Mode pop-up menu, or click 
Invert in the Inspector.

2. Position, Rotation, and Scale

3. The Match Move behavior is applied to the layer you want to 
inherit the new movement.

4. Command-drag the control point, (or Control-click the control 
point), and from the shortcut menu, choose Linear.

5. In the Inspector, click the Sample Color button and drag a 
selection rectangle around the additional color shades you 
want to remove.

6. The Spill Level parameter

7. Adjust the Shrink/Expand parameter to shrink the matte, or 
adjust the White point handle in the Spill Contrast graph.

8. The Light Wrap parameters can be found in the Keyer filter or 
in the Blend Mode menu on the Properties pane. You would 
use the Light Wrap in the Blend Mode menu when you plan 
to color correct the foreground of the key. Otherwise you can 
use the Light Wrap setting in the Keyer.

9. Select the Color checkbox in Motion Preferences, and move 
the pointer over pixels in the image.

10. The Strength slider adjusts the core transparency. When you 
reduce the slider value, you reduce the transparency by 
narrowing the range of green used to create the matte.

Keyboard shortcuts

Option-BB Choose the B-Spline Mask tool

Lesson Eleven Objectives
Upon completion of Lesson Eleven, “Publishing Smart Templates for Final 
Cut Pro X” in “Motion 5,” you should be able to complete the following 
tasks. Two items from this lesson are included in the pool of Level One 
exam questions. Questions are drawn randomly from the following 
objectives:

• Preview, apply, and adjust Final Cut Pro title effects

• Modify Final Cut Pro effects in Motion

• Create a Smart Motion Template from scratch

• Publish template parameters
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Lesson Eleven review questions
After completing Lesson Eleven, you should be able to answer the 
following questions. 

1. Name the four kinds of effects in Final Cut Pro.

2. In Final Cut Pro, if you can’t get the look you want for an 
effect by using the Published Parameters in the Inspector, 
how could you modify the effect?

3. How do you exit text editing mode?

4. In Final Cut Pro, how can you preview a title animation in 
both the thumbnail and in the Viewer before applying it to 
your project.

5. In Motion, what content does a Final Cut Title project already 
contain?

6. How can you force Final Cut Pro to play your opening title 
animation at the same speed as your Motion project, no 
matter how the duration of the title is trimmed in Final Cut 
Pro?

7. Describe two ways you can publish a parameter of a Motion 
Smart Template so that it’s available in Final Cut Pro.

8. How can you change the name of a published parameter?

Answers

1. Effects, Transitions, Titles, and Generators

2. Control-click the effect in the Browser, and choose “Open a 
copy in Motion” from the shortcut menu. Then change 
anything you like.

3. Press the Esc key.

4. Move the pointer or skim across the preview thumbnail.

5. A text layer and a placeholder layer named Title Background

6. In Motion, add a Build In marker to the Timeline on a frame 
after the opening animation has completed.

7. In Motion’s Inspector, use the Animation menu, or Control-
click the parameter name. Also, for some parameters, you can 
Control-click the parameter name in the HUD.

8. Select the project in the Layers list. Open the Project 
Inspector, and click the Publishing button. Double-click any 
parameter name to change it.

Keyboard shortcuts

Command-Tab Rotate through open applications

Command-0 In Final Cut Pro, opens the Project Library
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Command-4 In Final Cut Pro, opens the Inspector

Q In Final Cut Pro, connects the selected clip 
or effect to the primary storyline

Lesson Twelve Objectives
Upon completion of Lesson Twelve, “Rigging and Publishing Widgets” in 
“Motion 5,” you should be able to complete the following tasks. Three 
items from this lesson are included in the pool of Level One exam 
questions. Questions are drawn randomly from the following objectives:

• Rig and publish a checkbox widget for a Final Cut Pro title

• Analyze the structure of a Final Cut Transition project

• Connect parameters with the Link behavior

• Rig and publish a pop-up widget

• Create a Final Cut effect project

• Rig and publish a slider widget

Lesson Twelve review questions
After completing Lesson Twelve, you should be able to answer the 
following questions. 

1. What is the relationship between a rig and a widget?

2. Describe two ways to add a parameter to a widget.

3. What is the simplest type of widget and why? 

4. How do you know if a parameter has been rigged?

5. What does the green placeholder layer in a Final Cut 
transition project represent?

6. When you finish rigging a widget, what do you have to do to 
make it available in Final Cut Pro X?

7. In Motion, how can you display a list of all published 
parameters?

8. You want to rig a transition so that you can choose from five 
color themes in Final Cut Pro. What type of widget should you 
choose?

9. You want to rig a generator so that the Final Cut Pro editor 
can rotate all the graphics at once to point in any direction. 
What type of widget should you use?

Answers

1. A rig is a container for widgets, much like a group is a 
container for layers. Before you can add a widget to a Motion 
project, you must first add a rig to contain the widget.
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2. You can add a parameter to a widget manually by choosing 
Add to Rig > (Rig name) > Add to (Widget name), or 
automatically by clicking Start to enter into Rig Edit Mode 
and changing the value of the parameter.

3. A checkbox is the simplest type of widget because it has only 
two states: selected or deselected. Each state is called a 
snapshot and contains parameter values that you select. 

4. Next to the Animation menu of a parameter, a joystick icon 
indicates that the parameter is rigged.

5. A Final Cut transition contains a placeholder layer for each 
side of the edit point. The green layer, Transition A, represents 
the outgoing video clip; the red layer, Transition B, represents 
the incoming video clip.

6. You need to publish the widget to use it in Final Cut Pro X. 

7. In the Layers list, select the project, and then in the Project 
Inspector, select the Publishing pane.

8. The pop-up widget allows you to set as many discrete 
snapshots as you’d like to place in a menu.

9. The slider widget lets you set up snapshots for maximum and 
minimum values and then choose any value between them 
by dragging the slider.

Keyboard shortcuts

Command-Control-R New rig

Lesson Thirteen Objectives

Upon completion of Lesson Thirteen, “Building a 3D Scene” in “Motion 5,” 
you should be able to complete the following tasks. Four items from this 
lesson are included in the pool of Level One exam questions. Questions are 
drawn randomly from the following objectives:

• Manipulate layers and groups in 3D space

• Add and manipulate a camera

• Enable and work with 3D Canvas overlays

• Build and transform 3D scenes

• Work with axis modes

• Use multiple viewports 

• Use the Frame Object command

• Mix 2D and 3D groups
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Lesson Thirteen review questions
After completing Lesson Thirteen, you should be able to answer the 
following questions. 

1. How can you automatically switch all groups in your project 
to 3D? 

2. How do you add a camera?

3. Name three locations in which you can change the position 
and rotation of a layer or group in 3D space.

4. What’s the difference between layers in a 2D group and in a 
3D group?

5. Do the 3D View tools always control the camera? 

6. Which tool is used to make 3D transformations directly in the 
Canvas, and which keyboard shortcut selects it? 

7. How can you quickly move a camera to look at and frame a 
specific layer in 3D space? 

8. In the HUD, how would you set the Adjust Around pop-up 
menu if you wanted the z-axis of a layer to always point 
straight at you, no matter how the layer or the camera was 
oriented? 

9. If you applied an image mask to a layer that is positioned in 
3D space, why wouldn’t the image mask appear on the layer?

Answers

1. By adding a camera

2. In the toolbar, click the New Camera button or choose Object 
> New Camera.

3. In the Inspector, the HUD, or the Canvas

4. Layers in 2D groups are not affected by the camera, and are 
composited based on stacking order in the Layers tab.

5. No. The 3D View tools control the camera only when the 
window is set to a Camera view. 

6. The Adjust 3D Transform tool allows you to transform the 
position and rotation of layers and groups in both the HUD 
and the Canvas. Press Q to select the Adjust 3D Transform 
tool. 

7. Select the layer, and from the Camera menu, choose Frame 
Object, or press Shift-Command-F.

8. Set the Adjust Around pop-up menu to View Axis mode to 
orient the axes so that they reflect the orientation of your 
computer screen. 

9. The image mask source is not aligned to the layer you are 
masking.
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Keyboard shortcuts

Q Select the Adjust 3D Transform tool

Control-A Select the Active Camera view from the 
Camera menu

Control-D Toggle a group between 2D and 3D

Lesson Fourteen Objectives
Upon completion of Lesson Fourteen, “Building a 3D Scene” in “Motion 5,” 
you should be able to complete the following tasks. Four items from this 
lesson are included in the pool of Level One exam questions. Questions are 
drawn randomly from the following objectives:

• Animate a camera with behaviors

• Work with depth of field

• Turn on and adjust reflections

• Understand light types

• Work with casting and receiving shadows 

Lesson Fourteen review questions
After completing Lesson Fourteen, you should be able to answer the 
following questions. 

1. Name two of the Camera behaviors.

2. Can the stacking order of Camera behaviors change the 
camera’s animation? 

3. You used a Framing behavior to frame a group. You then 
rotate the group 180 degrees around its y-axis and drag it 
down 1,000 pixels. How will this transformation affect the 
camera? 

4. What types of behaviors, besides Camera behaviors, can you 
use to animate a camera? 

5. How do you limit the camera’s depth of field? 

6. How do you turn on reflections for a layer? 

7. You added a light and turned on shadows. Your text is 
throwing shadows onto the floor, which you want, but it is 
also throwing shadows onto another text layer, which you 
don’t want. What do you do?

Answers

1. Framing, Sweep, Focus, Dolly, Zoom In/Out, Zoom Layer

2. Yes. For example, if the Framing behavior is on top of a Sweep 
behavior, it will force the camera to frame the target layer 
face-on, even if the sweep tries to rotate it.
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3. The camera will also rotate 180 degrees and move down 
1,000 pixels to properly frame the group.

4. Basic Motion, Parameter, and Simulation behaviors—
basically, any behaviors that work on a layer will work on a 
camera.

5. From the Render pop-up menu, choose Depth of Field. 

6. In the Properties pane of the Inspector, select the Reflections 
checkbox.

7. Select the text layer that is receiving the shadows, and in the 
Properties pane, deselect the Receive Shadows checkbox.

Keyboard shortcuts

Option-L Turn on lights

Control-Option-D Turn on limited depth of field

Command-Shift-L Add a new light

Control-Option-R Turn on reflections

Control-Option-S Turn on shadows

Command-
Shift-’ (apostrophe)

Toggle 3D grid visibility

Taking the Level One Certification Exam 

The Level One certification exam must be taken at an Apple Authorized 
Training Center (AATC) in a proctored setting. To find the closest AATC, 
please visit training.apple.com/aatc. 

Many AATCs schedule “Certification Exam Sessions” at training.apple.com/
schedule. However, if you don’t see a session scheduled, you can contact 
the AATC and they will often schedule one for you. Please note that all 
AATCS can offer all Mac OS X and Pro Apps exams, even if they don’t offer 
the corresponding course.

Prometric Exam FAQs
Please visit training.apple.com/certification/faq for a list of frequently asked 
questions. If you do not find the answer to your question, then email us. 
Please allow at least two business days for a response.  

Motion 5 Level One Exam Preparation Guide

29

http://training.apple.com/aatc
http://training.apple.com/aatc
http://training.apple.com/schedule
http://training.apple.com/schedule
http://training.apple.com/schedule
http://training.apple.com/schedule
http://training.apple.com/certification/faq
http://training.apple.com/certification/faq
mailto:applecert@apple.com?subject=Apple%20Certification
mailto:applecert@apple.com?subject=Apple%20Certification

